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Information in this document is subject to change without notice and does not
represent a commitment on the part of the manufacturer. The software described
in this document is furnished under license agreement or nondisclosure
agreement and may be used or copied only in accordance with the terms of the
agreement. It is against the law to copy the software on any medium except as
specifically allowed in the license or nondisclosure agreement. The purchaser
may make one copy of the software for backup purposes. No part of this manual
may be reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying, recording, or information storage and
retrieval systems, for any purpose other than for the purchaser’s personal use,
without written permission.

Copyright © 1997-2016 ARM Germany GmbH
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registered trademarks of ARM Germany GmbH and ARM Ltd.
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Preface

Thank you for using the DS-MDK Development Studio available from ARM®.
To provide you with the very best software tools for developing ARM based
embedded applications we design our tools to make software engineering easy
and productive. ARM also offers therefore complementary products such as the
ULINK™ debug and trace adapters and a range of evaluation boards. DS-MDK
is expandable with various third party tools, starter kits, and debug adapters.

Chapter Overview

The book starts with the installation of DS-MDK and describes the software
components along with complete workflow from starting a project up to
debugging on hardware. It contains the following chapters:

DS-MDK Introduction provides an overview about the DS-MDK, the Software
Packs, and describes the product installation along with the use of example
projects.

Eclipse IDE explains the basic concepts of the IDE and the most frequently used
perspectives.

Create Cortex-M4 Applications guides you through the process of creating and
modifying projects using CMSIS and device-related software components for the
Cortex-M microcontroller.

Create Linux Applications shows you how to create and modify applications for
the Cortex-A processor running Linux.

Debug Applications describes the process of how to connect to the target
hardware and explains debugging applications on the target.

Store Cortex-M4 Image gives further details on how to store the application
image on the target and how to run it at start up time.
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NOTE

This user’s guide describes how to create applications with the Eclipse-based
DS-MDK IDE and Debugger for ARM Cortex-A/Cortex-M based NXP i.MX 6
and 7 series.

Refer to the Getting Started with MDK user’s guide for information how to
create projects for ARM Cortex-M microcontrollers using the uVision"

IDE/Debugger.
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DS-MDK Introduction

DS-MDK combines the Eclipse-based DS-5 IDE and Debugger with CMSIS-
Pack technology and uses Software Packs to extend device support for devices
based on 32-bit ARM Cortex-A processors or heterogeneous systems based on
32-bit ARM Cortex-A and ARM Cortex-M processors.

Initially, only NXP i.MX 6 and 7 series devices are supported that combine
computing power for application-rich systems with real-time responsiveness. For
such embedded systems, the DS-5 Debugger gives visibility to multi-processor
execution and allows optimization of the overall software architecture.

Solution for Heterogeneous Systems

ARM Cortex-A ARM Cortex-M

Common Peripherals
Shared Memory
Linux Application > RTOS System
Inter-Pracessor Communication

Heterogeneous systems usually consist of a powerful ARM Cortex-A class
application processor and a deterministic ARM Cortex-M based microcontroller.
These systems combine the best of both worlds: the Cortex-A class processor can
run a feature-rich operating system such as Linux and enables the user to program
complex applications with sophisticated human-machine interfaces (HMI). The
Cortex-M class controller offers low 1/O latency, superior power efficiency and a
fast system start-up time for embedded systems.

Usually, both processors have access to a set of communication peripherals and
shared memory. The biggest challenge with heterogeneous systems is the
synchronization and inter-processor communication.

DS-MDK offers a complete software development solution for such systems:

= [t allows managing Cortex-A Linux and Cortex-M RTOS projects in the
same development environment,
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= It fully supports the Cortex Microcontroller Software Interface Standard
(CMSIS) development flow for efficient Cortex-M programming. Software
Packs may be added any time to DS-MDK making new device support and
middleware updates independent from the toolchain. They contain device
support, CMSIS libraries, middleware, board support, code templates, and
example projects. The IDE manages the provided software components that
are available for the application as building blocks.

= The DS-MDK Debugger offers full visibility for multicore software
development.

DS-MDK Licensing

DS-MDK is part of the Keil MDK-Professional Edition and the product requires
a valid license for MDK-Professional Edition.

License Types

The following licenses types are available:

Single-User License (Node-Locked) grants the right to use the product by one
developer on two computers at the same time.

Floating-User License or FlexLM License grants the right to use the product on
several computers by a number of developers at the same time.

For further details, refer to the Licensing User’s Guide at
www.keil.com/support/man/docs/license.



http://www.keil.com/mdk5/cmsis/
http://www.keil.com/mdk5/editions/pro
http://www.keil.com/support/man/docs/license
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Installation

Software and Hardware Requirements
DS-MDK has the following minimum hardware and software requirements:
» A PC running a Microsoft Windows (32-bit or 64-bit) operating system
*  Dual-Core Processor with > 2 GHz

» 4GB RAM and 8 GB hard-disk space

= [280 x 800 or higher screen resolution

Install MDK

Download MDK from www.keil.com/download - Product Downloads and run
the installer. It also adds the Software Packs for ARM CMSIS and MDK
Middleware.

Follow the instructions on
www.keil.com/support/man/docs/license/license sul install.htm to activate a
MDK-Professional license, which is required for DS-MDK.

Install DS-MDK

Download DS-MDK from www.keil.com/mdk5/ds-mdk/install and run the
installer. Having finished the installation, start DS-MDK by clicking on Eclipse
for DS-MDK in the Start menu (Windows 10: All apps - ARM DS-MDK -
Eclipse for DS-MDK).

When starting the product the first time, you will be presented with a window
showing MDK installation detected in your system:

S Select MDK-ARM installation O X

Select MDK-ARM installation
Select the location of your MDK-ARM installation.

MDK-ARM installation directory: | C:\Keil_v3 | Browse...

- Discovered Information

|’?.>| Apply 8 Restart Cancel

If required, change the installation destination.


http://www.keil.com/download
http://www.keil.com/support/man/docs/license/license_sul_install.htm
http://www.keil.com/mdk5/ds-mdk/install
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Now, you need to specify a directory for your workspace (the area where your
projects will be stored). For most users, the default suggested directory is the best
option.

£ Workspace Launcher *
Select a workspace
Eclipse Platform stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session.
AL BTSN\ Users' USER\Documents'D5-MDK Workspace w Browse...
[[]Use this as the default and do not ask again
: . .
The Eclipse-based IDE opens in the C/C++ Perspective:
£ C/Ces - Eclipse Platform - o x
File Edit Source Refactor Navigate Search Project Run Window Help
- IR R SIS B R SR R SR St ks R [auickaccess || | [ %
[ Project Explorer 33 5% v=0 = O 5 Outiine 5% =g
An outline is not avalable.
[£2 Problems 2 =8
0items
Description ~ Resource Path Location Type

Refer to chapter Eclipse IDE on page 18 for more information on Eclipse
workbench concepts.
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Manage Software Packs

Use the CMSIS Pack Manager perspective for managing Software Packs on the
local computer.

Open this perspective using = Window > Open Perspective > CMSIS Pack
Manager. You should now install the Software Pack related to your target device
or evaluation board.

NOTE
Currently, only Software Packs for the NXP i.MX 6 and 7 series are qualified for
DS-MDK.

e
File Edit Nevigete Search Project Run Window Help
- 5 P e e T lauick pccess Ji] 5| B % @8
B Devices 32 Bl FE®|% T = B @Paxck 12 [ Eamples B B R EH T8 ack Properties 5 =S =g
Search Device Search Pack v £ KeiliMX7D_DFP.1.00
B Boards
Device Summary Pack Action Description A & Components
v 4 Al Devices 3660 Devices v ® Device Specific 32 Packs NXP selected B Devices
@ ABov 6 Devices 5 ClarinoxWireless & Install Clarinox Blugtooth Classic, Bluctooth Low Ener I Examples
@ Ambiq Micro 8Devices % KeiliMX7D_DFP Up o date | NXP M 7Dual Family Device Support and Exa
@ Analog Devices 16 Devices %4 Kell Kinetis_K0D_DFP Install Freescale Kinetis KOD Series Device Support
@ ARM 26 Devices 5 Keil Kinetis_K10_DFP Install Freescale Kinetis K10 Series Device Support
@ Atmel 260 Devices % Keil Kinetis_K20_DFP Install Freescale Kinetis K20 Series Device Support and
@ Cypress 425 Devices 5 Keil Kinetis_K30_DFP Install Freescale Kinetis K30 Series Device Support
@ GigaDevice 40Devices % Keil Kinetis_K40_DFP Install Freescale Kinetis K40 Series Device Support
@ Holtek 19 Devices *d, Keil Kinetic_K50_DFP Install Freescale Kinetis K50 Series Device Support
@ Infincon 151 Devices % Keil Kinetis_K60_DFP Install Freescale Kinetis K60 Series Device Support and
@ Maxim 4 Devices %4 Kell Kinetis_K70_DFP Install Freescale Kinetis K70 Series Device Support and
@ Mediatek 2Devices 5 Keil Kinatis_Kke0_DFP Install Freescale Kinetis K60 Series Device Support
@ Microsemi 6Devices s Keil Kinetis_KEA<_DFP Install Freescale Kinetis KEAwx Series Device Support a
@ MindMotion 2 Devices B3 Kel Kinetis_KEsx DFP Install Freescale Kinetis KEsx Series Device Support
@ Nordic Semiconductors 8 Devices s Keil Kinetis_KLo DFP Install Freescale Kinetis KL« Series Device Support an:
@ Nuvoten 433 Devices %4 Keil Kinetis_KNbo DFP Install Freescale Kinetis KMo Series Device Support ar
@ N 527 Devices % Keil Kinetis_KSo, DFP Install Freescale Kinetis KSix Series Device Support
@ Renesas 3 Devices % Keil Kinetis_KVac_DFP Install Freescale Kinetis Kiicc Series Device Support
@ silicon Labs 397 Devices 5 Keil Kinetis KWPRI516_DFP Install Freescale Kinetis WPRIS 16 Series Device Suppo
@ SONiX 49Devices % Keil Kinetis_ Ko DFP Install Freescale Kinetis KiWia Series Device Support
@ STMicroelectronics 246 Devices ‘A’d, Keil Kinetic_SDK_DFP Install Freescale Kinetis SDK v1.2.0 including MK&4FN
@ Texes Instruments 342 Devices 5 KeilLPCT100_DFP Install NXP LPCT100 Series Device Support
@ Toshiba 90 Devices % KeilLPC1200_DFP Install NXP LPC1200 Series Device Support
5 KeilLPC1300_DFP Install NXP LPC1300 Series Device Support
% KeilLPC1500_DFP Install NXP LPC1500 Series Device Support and Examg
*d, Keil LPC1700_DFP Install INXP LPC1700 Series Device Support, Drivers an
% KeilLPC1800_DFP Install NXP LPC1800 Series Device Support, Drivers an
% Keil LPC4000_DFP Install INXP LPC4000 Series Device Support
5 KeilLPC4300 DFP o Instal INXP LPC4300 Series Device Supvort. Drivers an ¥
< DI >
B Console 53 % MBE-0-=10

CMSIS Pack Manager console
15:50:57: Installing Pack Keil.iMX7D_DFP.1.0.@ completed

ONLINE

The Console window shows information about the Internet connection and the
installation progress.

T1P: The device database at www.keil.com/dd2 lists all available devices and
provides download access to the related Software Packs. If the Pack
Manager cannot access the Internet, you can manually install Software
Packs using the Import existing packs icon ¢ or by double-click on
* PACK files.



http://www.keil.com/dd2
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Install the Linux Image
Currently, DS-MDK supports the following development board:
* NXPi.MX 7 SABRE development board: MCIMX7SABRE

For this development board, a pre-configured Linux image with DS-MDK
specific debug settings is available. Please download the zipped image file here:
www.keil.com/mdkS/ds-mdk/imx7reference

All steps to create a Linux image for the MX7DSABRESD board are explained in
the documentation. Please refer to the Freescale Yocto Project User's Guide
and the i.MX Linux User's Guide. The above website also links to these
documents and explains the changes that are required for DS-MDK debugging
using ULINKpro.

Copy the Linux Image to an SD-Card

Once you have downloaded the zipped Linux Kernel image, you need unzip it
before you can flash it onto an SD-Card. Windows users can use the open source
tool Win32 Disk Imager from http://win32diskimager.sourceforge.net/.

Install and run the tool. To write the image to the memory card, specify the
location of the image file, select the Device letter of the SD card and press the
Write button:

%

Image File Device

| rootfs.sdcard | hd

Copy | [ | MD5 Hash:

Progress

Version: 0.9.5 Cancel Read Write Exit


http://www.keil.com/mdk5/ds-mdk/imx7reference
http://win32diskimager.sourceforge.net/
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Hardware Connection

i.MX 7 SABRE Board
= Insert the SD-Card with the Linux image into the slot labelled SD1 BOOT.

= Connect the ULINKpro debug adapter using the 10-pin ribbon cable to
J12 JTAG.

= Connect your computer using a Micro-USB cable to the USB connector
labelled DEBUG UART. Your Windows PC will automatically detect a dual
USB serial port component and will install the required drivers.

= Connect the 5V power supply to J1.

ARMKEIL  ULINKpro

Microcontroller Tools
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Verify Installation using Example Projects

Once you have selected, downloaded, and installed a Software Pack for your
device, you can verify your installation using one of the examples provided in the
Software Pack.

Remote Processor Messaging Protocol Example

The .MX 7 Device Family Pack contains two example projects that show how
the two processors communicate with each other using the remote processor
messaging protocol (RPMSG) via a TTY serial device. The TTY device is
installed on the Linux system using a Linux kernel module (imx_rpmsg_tty.ko).

Cortex-A Nxo Cortex-M

o Corsoie 3| . & Temnal M4 £3 |
1 Get Message From I_MX7 I Get Message From
Remote Side: Master Side:
Hello from M4! ARM®Cortex®-A7 "Hello from A7!"

2 Child exited with [len : 14]
status 0

Linux Application RTOS System

F 3 a

::

The Linux Application TTY runs on the Cortex-A7 processor and writes a
message to the TTY device. This message is shown in the terminal of the RPMSG
TTY RTX application running on the Cortex-M4 processor. This application
responds on the TTY device, which is read by the Linux application and shown in
its console.

ARM®Cortex®-M4
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Copy the RPMSG TTY RTX Example Project

@) Inthe CMSIS Pack Manager perspective, select the Examples tab. Use
filters in the toolbar to narrow the list of examples.

B Devices 32 B H 5 ®@|% = 8 |@Packs % bemples 22 [ Only show eamples from installed packs | (2) | & (2 & ¥ = 5

Search Device

Search Example

Device Summary A | Bemple Action Description
v @ NP 527 Devices CMSIS-RTOS Blinky (MCIMX7D-SABRE) & Copy CMSIS-RTOS based Blinky example for Cortex-h4
v %MK T Series 1 Device Linux Application TTY (MCIMX7D-SABRE) s Copy Linux Application TTY exsmple
v 4 iMX 7Dual 1 Device RPMSG PingPong BM (MCIMX7D-SABRE) & Copy Bare-Metal RPMSG PingPong example for Cortex-h4
B MCIMXTD  ARM Cortex-A7, ARM RPMSG PingPong RTX (MCIMXTD-SABRE) & Copy CMSIS-RTOS RTX and Bare-Metal RPMSG PingPong ex
%44 K Series 1 Device RPMSG TTY RTX (MCIMX7D-SABRE) & Copy CMSIS-RTOS RTX TTY example for Cortex-h4
“ KOO Series 2 Devices

Click Copy next to the RPMSG TTY RTX example. A new window opens
asking you to verify the selected example project:

Project Name:

RPMSG_TTY_RTX_M4

& Copy Example to Eclipse Workspace *
Example: RPMSG TTY RTX
Pack: Keil.iMX7D_DFP.0.1.10

Project Location: C:\Users\USER\D'ocuments\D5-MDK Workspace\RPMSG_TTY_RTX_M4

Cancel

CMSIS Pack Manager copies the example into your workspace and switches
automatically to the C/C++ perspective:

© C/Cr+ - RPMSG_TTY_RTX_W4/RPMSG_TTY_RTX_M4.rteconfig - Eclipse Platform

- o x
Flle Edit Source Refactor Navigate Search Project Run Window Help
- MR S B R R AR CR Ry KA BT BT M=t [Quick Access ]| g% | [ER % @
[ Project Explarer 52 B % 7S 0O ¢ RPMSGITY_RTX Mdrteconfig 53 = B g Outine =g
v (5 RPMSG_TTY_RTX_M4 & Components (2]
BV Includes An outline is not available.
v & RTE Software Components Sel.  Variant Vendor Version  Description
(= Board Suppart B MCIMXTD:Cortex-h4 NKP ARM Cortex-4, 64 kB RAM, 32 k
(& CMsIS MCIMXTD-SABRE  Keil 100 , IMX7D SABRE Board
(= Compiler X Cortex Microcontroller Software |
(= Device € CMSIS Driver Unified Device Drivers compliant
(& OpenAMP & Compiler ARM Compiler Software Extensiol
RTE_Components.h @ Device Startup, System Setup
[£] hardware_init.c @ File System MDK-Plus. . Keil 620 . File Access on various storage de|
(8] ty_rbxc MDK-Plus. , Seqger 5322, UserInterface on graphical LED d
[E) MCIMXTD_Cortex-Md.sct MDK-Plus . Keil 720 . |Pv4 Networking using Ethernet o
€ RPMSG_TTY_RTX M4 rteconfig
MDK-Plus. , Keil 620 . USB Communication with variou|
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Build the Application

Build the project from the context menu in the Project Explorer:

L5 Project Explorer 53 9% ¥ = O € RPMSG_TTY_RTX_M4.rteconfig i3
v (5 RPMSG_TTY_RTX_M4 & Camnonents [
[t Inclu MNew ¥
v ft RTE Go Into omponents Sel.
=B MX7D:Cortex-h4
= C Open in New Window rd Suppart
=C 5I5
C
=D H: P IS Driver
=0al Paste mpiler
R 3 Delete ice
[£] hardy Move... Systermn
[ ty.re Rename... phics
[E] macin work
€ RPM! juy  Import.. enAMP
g Export..
€ CMSIS C/C++ Project »
Build Project
Clean Project

The Console window shows information about the build process:

Bl Console &2 &4 <§|)| =Y
COT Build Console [RPMSG_TTY_RTX_M4]
Total RO Size (Code + RO Data) 28276 ( 27.61kB)
Total RW Size (RW Data + ZI Data) 31856 ( 31.11kB)
Total ROM Size (Code + RO Data + RW Data) 28396 ( 27.73kB)

fromelf --bin

--output=RPMSG_TTY_RTX_M4.bin RPMSG_TTY_RTX_M4.axf

15:55:26 Build Finished (toock 37s5.283ms)

% | #B-S-=1o
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Copy and Build the Linux Application TTY

Switch back to the CMSIS Pack Manager perspective and copy the
Linux Application TTY example project to your workspace.

Build the project from the context menu in the Project Explorer. The Console
should show an error-free build:

B Console 3 4 {45 LB BE % | M B~Civ= 08
DT Build Conscle [Linux Application TTY]
........ P L SRR
'Invoking: GCC C Compiler 4 [arm-linux-gnueabihf]’ ~
arm-linux-gnueabihf-gcec -08 -g -Wall -c -fmessage-length=8 -MMD -MP -MF"src/LinuxTTY.d" -M
'Finished building: ../src/LinuxTTY.c'

'Building target: Linux Application TTY'

'Inveoking: GCC C Linker 4 [arm-linux-gnueabihf]’
arm-linux-gnueabihf-gcc -o “Linux Application TTY" ./src/LinuxTTY.o
'Finished building target: Linux Application TTY'

15:56:28 Build Finished (tock 1s.39@ms)
v

£ >

The chapter Debug Applications on page 36 explains how to debug both
applications using the DS-5 Debugger.

Documentation and Support

DS-MDK provides online manuals and context-sensitive help. The Help menu
opens the main help system that includes the CMSIS C/C++ Development User’s
Guide, the ARM DS-MDK Documentation, the RSE User Guide, and other
reference guides.

Many dialogs have context-sensitive Help buttons that access the documentation
and explain dialog options and settings.

If you have suggestions or you have discovered an issue with the software, please
report them to us. Support and information channels are accessible at
www.keil.com/support.



http://www.keil.com/support
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Eclipse IDE

DS-MDK uses Eclipse for DS-5, an Integrated Development Environment (IDE)
that combines the Eclipse IDE from the Eclipse Foundation with the compilation
and debug technology of the ARM tools.

You can use Eclipse for DS-5 as a project manager to create, build, debug,
monitor, and manage projects for ARM targets. It uses a single folder called a
workspace to store files and folders related to specific projects.

Users can extend its abilities by installing plug-ins written for the Eclipse
platform, such as the CMSIS Pack Manager and Remote System Explorer,
included in DS-MDK.

Workbench

The workbench is the main development environment where you can manage
individual projects, associated sub-folders, and source files.

Each workbench window links to one workspace. If you want to use different
workspaces at the same time, you can launch several workbench windows and
link each one to a different workspace.

Perspectives

A workbench contains multiple perspectives. Each perspective contains an initial
set and layout of views. It aims at accomplishing a specific type of task, such as
project creation and build, debugging, and Pack management. While working
with DS-MDK, you will switch perspectives frequently. It is always possible to
change a perspective layout and to add new views to it.

DS-MDK uses mainly these perspectives:

= C/C++ Perspective

= CMSIS Pack Manager Perspective

= Remote System Explorer Perspective

= DS-5 Debug Perspective
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C/C++ Perspective

This perspective is designed for working with C/C++ projects. By default, it
consists of an editor area and views for project management, tasks, properties,

and a console for messages.

The editor area of the C/C++ perspective in DS-MDK includes the Manage Run-

Time Environment window that lets you select software components, target

devices, and Software Packs for the current project.

It also features a graphical editor for files that have CMSIS Configuration Wizard

Project Explorer Dependency Check Manage Run-Time Environment Console
& C/Cen - RPMSG_TTY| RTX_M4/RPMSG_TTY_RTX_MA4.rteconfig - Eclipse Platform -| o x
File Edit Source Reffctor Navigate Search Project Run Window Hel
ARSI SRS B AR AE R AR MU R SR T | £ IR @
[ty Project Bxplorer 52 |[E] % ¥ = O | "RPMSG_TTY_RTX Md.rteconfly 52 | 3= RTX_Conf CM.c [€] hardware_init.c = 0 | % Outline 33 =g
v & L:uxApph(almnm & Components* (- Resol @
3, Binaries An outline is not available.
) Includes Software Companents Sel.  Variant Vender Version  Deseription ~
8 src B MOMXTD:Cortex-M4. NXP ARM Cortex-M4, 64 kB RAM, 32 kB R
= Debug € Board Support MCIMX7D-SABRE  Keil 100 iMX7D SABRE Board
v 5 RPMSG_TTV_RTX_M4 v & Cmsis Cortex Microcontroller Softurere Inte
&) Includes @ CORE m| ARM 500, CMSIS-CORE for Corter-M, SC000, §¢
(&> Debug @ Dsp [m] ARM 146 , CMSIS-DSP Library for Cort
vt RTE % RTOS (4P)) 0
(&= Board_Support % RTOS2 (API) 20
v = CMsls € CMSIS Driver Unified Device Drivers compliant
8] RTX_Conf_CM.c [ARM:CMSIS. € Compiler ARM Compiler Software Extensions
4 RTXCM3Jib [ARM:CVSISETC | o @ Deviee Startup, System Setup
(= Compiler v @ iMXTD HAL
= Device @ cem Keil 100, Clock Control Module
(& OpenAMP ¢ MU Keil 100 , Messaging Unit
RTE_Components.h @ RDC Keil 100 , Resource Domain Controller
8] hardware nit.c @ UART Keil 100 Universal Asynchronous Receiver/Tre
€] ty_rbee @ Startun M Keil 100 NXP iMX7D (M4 devices v
[E] MCIMX7D_Cortex-Md.sct < >
<p RPMSG_TTY_RTX_ M. rteconfig Validation Output Description A
v /A, KeilMCIMX7D-SABRE: Board Support.iMXTD SABRE Board, HW INIT Additional software components required
~ /A require Celass="CMSIS", Cgroup="CORE" Select component from list
@ ARM:CMSIS.CORE (CMSIS-CORE for Cortex-M, SCO00, SC300, ARMvE-M
©o A Kl MACIMAY TS ARREBrarrd et IMY TN SARRE Bvarel | car 1/ Aellitinmal enfhusare ramnnants s irer
< >
Components| Device | Packs
2 Console 3 OB BEEEE B -=8
COT Build Console [RPMSG_TTY_RTX 4]
"
Total RO Size (Code + RO Data) 28292 ( 27.63kB)
Total RW Size (RW Data + ZI Data) 31856 ( 31.11kB)
Total ROM Size (Code + RO Data + RW Data) 28412 ( 27.75kB)
13:45:01 Build Finished (took 21s.546ms)
v
< 5 (3 >

For more information, refer to the C/C++ Development User’s Guide and the
CMSIS C/C++ Development User’s Guide available from the Eclipse help

system (Help = Help Contents).

The C/C++ perspective contains views that are tailored for specific needs.
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AXF File Viewer

An AXF file is the executable image generated by the ARM linker that contains
object code and debug information. Open it from the Project Explorer to inspect
the contents of the image.

&) RPMSG_TTY_RTX Md.axf 52

Header

% |0

Machine class

Data enceding
Header version
Operating System ABI
ABI version

ELFCLASS32 (32-bit)
ELFDATAZLSE (Little endian)
EV_CURRENT (Current version)
nene

[

File type ET_EXEC (Executable file) (2)
Machine EM_ARM (Advanced RISC Machines ARM)
Image entry point @x1FFFB299

Flags EF_ARM_HASENTRY + EF_ARM_ABI_FLOAT_SOFT (Bx85880202)
Header Size 52 bytes (@x34)

Segment header entry size 32 bytes (@x20)

Section header entry size 48 bytes (8x28)

Program header entries 1

Section header entries 16

Program header offset 5497228

Section header offset 5497252

Section header string table index 15

Header | Sections| Segments  Symbel Table | Disassembly

CMSIS Configuration Wizard

Files containing configuration annotations may be modified using a graphical
editor. Right-click on a file in the Project Explorer and select Open With =
CMSIS Configuration Wizard. Verify and adapt the contents directly in the
graphical representation of the text file.

= RTX_ConfCM.c 3 = O
= CMSIS Configuration Wizard =N =NG)
Option Value G
~ Thread Cenfiguration
Number of concurrent running user threads 6
Default Thread stack size [bytes] 1024 4
Main Thread stack size [bytes] 1024 A
Number of threads with user-provided stack size 0
Total stack size [bytes] for threads with user-provided stack size 0
Stack overflow checking
Stack usage watermark ]
Processor mode for thread execution Privileged mode |
~ RTX Kernel Timer Tick Configuration
Use Cortex-M SysTick timer as RTX Kernel Timer
RTQS Kemel Timer input clock frequency [Hz] 24000000
RTX Timer tick interval value [us] 1000
+ System Configuration
« Round-Robin Thread switching
Round-Rohin Timenut Iticks] 5 ¥
< >

Number of concurrent running user threads
Defines max. number of user threads that will run at the same time.
Default: &

Source Editor | CMSIS Configuration Wizard
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Scatter File Viewer

Scatter files (*.sct) are used to specify the memory map of an image to the linker.
The Scatter File Viewer lets you inspect this text file in a graphical
representation. Edit the file contents using the filename.sct tab (refer to Adapt
the Scatter File on page 32).

[E] MCIMXTD _Cortex-Mé.sct 2% =9
OKFFFFFFFF T OXFFFFFFFF |
LR IROM1 RW_IRAM1
ANY (+RW, +ZI
LR_IROMT s l
(20000000
ER_IROM1

*.0 (RESET, +First)
* (InRoot$SSections)
AMY (+RO)

Ox1FFFB000 01 FFFB000
000000000 & : 0xD0DODO0D ¢

Load Regions Execution Regions
< >

Regions/Sections  MCIMX7D_Cortex-Md.sct
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CMSIS Pack Manager Perspective

The Pack Manager perspective offers the following functionality:
= Install or update Software Packs.

= List devices and boards that are supported by Software Packs.

= List example projects that can be copied into the Eclipse workspace.

To open this perspective, use the = icon and select CMSIS Pack Manager

Device Database Available Packs/Examples Pack Properties
£ CMSIS Pack Manager - RPMSG_TTY_RTX_M4/RPMSG_TTY_RTX_M4.rteconfig - Eclipse Platform - X
File Edt Navigate Searfh Project Run Window Help
mRAFERERREE e S FU RS SRR S SR el =l 5%
B Devices 57 B EE®| % =8 @& % Bxamples 52 [ Only show examples from installed packs | @ | & (% ¢ ¥ = B | = Pack Properties I =0
Search Device Search Example mEle -
Device Summary A EBxample Action Description v & KE"B'MXZD-DW"” °
v o Ne 527 Devices CMSIS-RTOS Blinky (MCIMX7D-SABRE) € Copy CMSIS-RTOS based Blinky example for Cortex- 4 veE EHV’\I;P:‘M[\MXYDVSAERE
v %3 IMX 7 Series 1 Device Linux Application TTY (MCIMX7D-SABRE) (& Gopy. Linux Application TTY excmple + & Components
~ % iMXTDusl 1 Device RPMSG PingPong BM (MCIMX7D-SABRE) (¢ Copy. Bare-Metal RPMSG PingPong example for Cortex-Md M
. MCIMXTD ARM Cortex-A7, ARM RPMSG PingPong RTX (MCIMX7D-SABRE) Copy CMSIS-RTOS RTX and Bare-Metal RPMSG PingPong exan @ Startup
1% K Series 1 Device RPMSG TTY RTX (MCIMX7D-SABRE) 4 Copy CMSIS-RTOS RTX TTY example for Cortex-M4 v @ IMXTD HAL
4 K0 Series 2Devices @ UART
4 K10 Series 23 Devices e
% K20 Series 41 Devices @ ccm
4 K30 Series 6 Devices ¢ RDC
4 K40 Series 6Devices @ BoardSupport
48 K50 Series 12 Devices @ OpentMP
4 Ke0 Series 18 Devices
“% K70 Series 4 Devices h - Devices
i v %3 LMXT Series
4 K80 Series 2Devices < 83 1K Dl
4 KA Series 6Devices B VoD
4 Kb Series 21 Devices o
% KborSeries 33 Devices CMSIS-RTOS Blinky (MCIMX7D-5
16 Kibi Series 14 Devices Linux Application TTY (MCIMXTC
T8 KouSeres 2Devices RPMSG PingPong BM (MCIMXTD
:; :\‘{VZS::; ‘Zj g:z:z RPMSG PingPong RTX (ME\MX’[
4 LPCI100 Series 128 Devices
4 LPC1200 Series 12 Devices
4 LPCI300 Series 24 Devices
1% LPC1500 Series 13 Devices
# LPC1700 Series 21 Devices
4 LPC1800 Series 21 Devices
2 LPCA000 Series 16 Devices v
< > llc 51|« >
B Console 12 S oG AR lMB--= 8
CDT Build Console [RPMSG_TTY_RTX_ 4]
-
Total RO Size (Code + RO Data) 26292 ( 27.63ks)
Total RW Size (RW Data + ZI Data) 31856 ( 31.11kB)
Total ROM Size (Code + RO Data + Ru Data) 28412 ( 27.75k8) .
< >
ONLINE

For more information, refer to the CMSIS C/C++ Development User’s Guide
available from the Eclipse help system (Help = Help Contents).
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Remote System Explorer Perspective

The Remote System Explorer (RSE) is a workbench perspective that allows you
to connect and work with a variety of remote systems. With predefined plug-ins,
you can look at remote file systems, transfer files between hosts, do remote

search, execute commands and work with processes.

Remote Systems

File/System Properties

Source Code Editor

Remote System Details

© Remote System Explorer -

/1041113071

File Edit Navigate Search

- [ Lo

48 Remote Systems 7

£ &
v Ef Local
#2y Local Files

% Local Shells
v T3 iLMX7_SABRE

~ (= tmp

1
(9 lost+found
v (= medis

Project Run Wi

lels

2 Linux Application T|
7| keepbusy.sh

dow Help

pbusy.ch - Eclipse Platform

IR -0 Qi - o
O [ keepbusysh 53
- Lwhile 13 do :; done &

A

v

=8 | 48 Remote System Details 53 | =] Tasks

= sd0
= mnt
<
[ Properties 12
EREo
Property Value
Canonical Path  /home/root/keepbusy.sh
Classification  executable
Extension sh
Filter string /home/root/*
Group 0
Hidden No
Lost modified 11 February 2016 15:58:21
Location /home/root
Name keepbusy.sh
Number of childre 0
Owner
Permissions rvrwar

< Root Connections
~ | Resource Parent profile
EfLocsl DESKTOP-SETOQPL  Local
T5iMX7_SABRE DESKTOP-SGTOQPL  SSH Only
v
> <

Remote system type

Connection status
Some subsystems connected
Some subsystems connected

- o x

Quick Accesd || 55 | @ 2 @8
= O = futline 2 = O
An btiing is not available.

t

=g

il
o9

Host name Default User D Description
LOCALHOST USER
10411130 root

For more information, refer to the RSE User Guide in the Eclipse help system
(Help = Help Contents).
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DS-5 Debug Perspective

Using DS-5 Debugger, you can debug bare-metal, RTOS, and Linux applications
with comprehensive and intuitive views, including synchronized source and
disassembly, call stack, memory, registers, expressions, variables, threads,

breakpoints, and trace.

Debug Control  Source Code Editor ~ Target Connection Disassembly Variables
& D5-5 Debug Linux Application TTV/src/LinuxTTY.c - Eclipse Flatform - o X
File Edit Sourfe Refactor Navigate Search Project Rup Window Help
B IETE RE T R ] R R th 5| e
& Debug Con... 37 | [ Project Exp... 4§ Remote Sy. = I commanas 32 @ B BB @ = 8 @=Verab.. 2 En = B8
SR R TR A ML s vareLories seor D el e ks - o N
- set debug-from main ~
~ T& GDB Debug application exit: code 255 z::‘ Name Value Type | Count | Size
5 G Locals 5 variables "
@ Application terminated #2 terminated Execution stopped at breakpoint 1: 0x000086F4 B .
B RPMSG_TTY_RTX_M4 disconnected Tn LinuxTTY.c
ox000086F4 61,8 | 1
Deleted temporary breakpoint: 1 1
wait
continue 5. 4 2
NORMAL_TERMINATION o | & Flesuticfarables  0of0varisbies v
< > < >
Status: application exit: code 255 Command:[Press (Ctrl+Space) for Content Assis Submit || [Add Variable Browse...
8 LinuxTTY.c 53 = O if} Disassem.. =0
t " P
printf (“Error %d from tcsetattc”, errno); P
return 13 S
B D -[ <Net Instruction= [ 100
return 8; Address | Opcode | Disassembly
BxO00BEEFE {r7.pc} "
00008672 NoP
main(int argc, char *argu[]) el
0x0000B6F4 PUSH {r4,r7,lr}
char *portname = "/dev/ttyRPMSG"; 0x2008B6FE sug Sp,sp,ROR24
0x000856F5 DD r7,sp, %0
int fd - open (portname, O_RDWR | O_NOCTTY | 0_SYNC); 0xB006B6FA STR ro, [r7,44]
if (fd <o) ©x000086FC STR r1,[7,#2]
H x000856FE mov r3, doxss1c
printf ("Error ¥d opening ¥s: ¥s", errno, portname, strerror (errno)); 0x@0065702 novT 3.%0
return -1 2x60068706 STR r3, [r7,#0x1c] v
) < >
set_interface_attribs (fd, B115208, 8); I App Console 53 =8
write (fd, "Hello from A7!", 14);
usleep (10000);
Listening on port 5000
char buf[14]; Debug session has been started, connecting to gdbserver
78 read (fd, buf, sizeof buf); Remote debugging from host 10.41.150.26
9 Error 2 opening /dev/ttyRPMSG: No such file or directory
50 printf ("Get Message From Remote Side: %s", buf); Child exited with status 255
81 2 v
< > < >
T GDB Debug application exit: code 255 (Linux Application Debug - Application Debug)

For more information, refer to the ARM DS-5 Debugger Documentation in the
ARM DS-MDK Documentation available from the Eclipse help system (Help 2>

Help Contents).
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Create Cortex-M4 Applications

This chapter guides you through the steps required to create and modify projects
for the Cortex-M target in a heterogeneous system. The tutorial creates a project
called Blinky using the real-time operating system CMSIS-RTOS RTX.

Blinky with CMSIS-RTOS RTX

The section explains the creation of the project using the following steps:

Setup the Project: create a project and select the microcontroller device
along with the relevant CMSIS components.

Select Software Components: choose the required software components for
the application.

Customize the CMSIS-RTOS RTX Kernel: adapt the RTOS kernel.
Create the Source Code Files: add and create the application files.

Build the Application Image: compile and link the application.

For the Blinky project, you will create and modify the main.c source file which
contains the main() function that initializes the RTOS kernel, the peripherals, and
starts thread execution. In addition, you will configure the system clock and the
CMSIS-RTOS RTX.
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Setup the Project

From the Eclipse menu bar, choose File > New - C Project:

& C++ Project O bt
C++ Project p—
Create C++ project of selected type
Project name: | Blinky
Use default location
Ch\Users\USER\D ocuments\D5-MDK Workspace\Blinky Browse...
default
Project type: Toolchains:
~ [= Executable ~ ARM Compiler 5.06u2
@ Empty Project ARM Compiler 6.4
® Hello World C++ Project GCC 4 [arm-linux-gnueabihf] (built-
& CMSIS C/C++ Project v||< >
Show project types and toclchains only if they are supported on the platform
l:?) < Back Mext > Finish Cancel

Select CMSIS RTE C/C++ Project, enter a project name (for example Blinky)
and click Next. In the following window, you can select to create a default main.c
file. Do not use this option. We will add a main.c template file later from a

Software Pack, so click again Next.
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In the following step, select your target device:

& C++ Project O x
Select Device .
Device: MCIMXTD:Cortex-M4 CPU: ARM Cortex-M4
Vendor: MNXP Max. Clock:
Pack:  KeiliMX7D_DFP.0.1.7 Memory: 64 kB RAM, 32 kB ROM
URL: http:/Swww.keil.com/dd2/nxp/mcimx7d - FPU: none
Search: | | Endian: Little-endian
w @ NXP A | | The i.MX 7Dual family of processors features A
v 4% MK T Series an advanced implementation of the ARM
v %2 i.MX TDual Cortex-AT core, which operates at speeds of
Lo up to 1 GHz, as well as the ARM Cortex-M4
v g MCIMXTD core.
B MCIMXTD:Cortex-AT - Heterogeneous Multicore Processing
B MCMXTD:Corte-M4 |, | | Architecture, up to Dual Cortex-AT and e
(?3' < Back Mext = Cancel

Select the NXP = i.MX 7 Series = i.MX Dual - MCIMX7D:Cortex-M4
device and click Finish. The C/C++ Perspective will open and show the current
project:

£ C/C++ - Blinky/Blinky.rteconfig - Eclipse Platform - o x
Fle Edit Source Refactor Navigate Search Project Run Window Help
n ] [ B R N @ e - @O Qi D e e - o B &
[ Project Explorar 51 E G ¥ = O | Binkyreconfi 57 = 0O | B= Outline 22 =0
v (5 Blinky % Components [ @
) Includes An outline is not available.
~ s RTE Software Components Sel.  Variant Vendor Version Description
[§) RTE.Components.h B MCIMX7D:Cortec- M4 Nxp ARM Cortex M2, 641kB RAM, 32k
4 Blinky.rteconfig % Board Support MCIMX7D-SABRE  Keil 100, iMX7D SABRE Board
@ MCIMXTD_Cortex-Md.sct & cmsis Cortex Microcontroller Software |
(5 RPMSG PingPong BM & CMSIS Driver Unified Device Drivers compliant
@ Compiler ARM Compiler Software Extension
& Device Startup, System Setup
& File System MDK-Plus kel 670  File Access on various storage de|
@ Graphics MDK-Plus , Segger 5322, Userinterface on graphical LCD d
@ Network MDK-Plus el 710, Pul Networking using Ethernet o
OpenAMP
P
& uss MDK-Plus kel 670, USB Communication with variou|
< >
Validation Output Description
< >
Components| Device| Packs
B Console 57 2| ®mB-mv=0
CMSIS RTE console [Blinky]
11:00:06 **** Updating project Blinky
Updating resources
Updating build settings
Project updated successfully
< >
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Select Software Components

For the Blinky project based on CMSIS-RTOS RTX, you need to select the
following components:

CMSIS:RTOS (API):Keil RTX.

Device:i.MX7D HAL:CCM

Device:i. MX7D HAL:RDC

Device:i.MX7D HAL:UART

Compiler:I/O:STDERR configured as variant User
Compiler:I/O:STDIN configured as variant User
Compiler:I/0O:STDOUT configured as variant User

Board Support:iMX7D SABRE Board:HW INIT

Board Support:iMX7D SABRE Board:User I/O Redirect

Use the Resolve button to add other required components automatically. Finally,
save your selection:

& "Blinky.rteconfig 32

= 0

4 Components Resolvejvalidation)messaaes Savepwhen ch-n_eT')

Software Components Sel,

B MCIMXTD: Cortex-M4
~ & Board Support
~ @ iMX7D SABRE Board
@ HWINIT
# User /0 Redirect
& CMsIs
# CORE
@ DSP
~ @ RTOS (AP])
@ Keil RTX
& CMSIS Driver
& Compiler

<

<

@ Event Messaging
v @10
@ File
¥ STDERR
@ STDIN
@ STDOUT
@ TTY
v & Deviee
v @ iMXTD HAL
@ cam
@ MU
@ RDC
@ UART
<

Validation Qutput
v /b ARM:CMSISRTOS Keil RTX

v /L require Cclass="Device", Cgroup="Startup"

W Keil::Device.Startup

ORERO O |

RIEOE

Variant

Vendor  Version Description

NXP

MCIMX7D-SABRE  Keil

DAP

File System
User
User
User
Breakpoint

ARM
ARM

ARM

Keil

Keil
L Keil
L Keil
, Keil
, Keil

Keil
Keil
Keil
Keil

~

ARM Cortex-M4, 64 kB RAM, 32 kB ROM
1.00  iMX7D SABRE Board

Board specific settings for hardware initialization
User 1/0 Redirect to UART
Cortex Microcontroller Software Interface Components
430 |, CMSIS-CORE for Cortex-M, SCOD
146  CMSIS-DSP Library for Cortex:
10 ., CEMSIS-RTOS API for Cortex-M, S
4800 , CMSIS-RTOS RTX implementation for Cortex-M, SC000, anc
Unified Device Drivers compliant to CMSIS-Driver Specifica
ARM Cempiler Software Extensions
100 Event Messaging using Debug Access Part (DAP)

110, Use retargeting together with the File System component

110, Redirect STDERR to a user defined output target (USART, Gr

1.1.0 | Retrieve STDIN from a user specified input source (USART,

1.1.0 | Redirect STDOUT to a user defined output target (USART, G

110 | Stop program execution at a breakpoint when using TTY
Startup, System Setup

1.00 | Clock Control Module

100, Messaging Unit

1.00 |, Resource Domain Controller

1.00 | Universal Asynchronous Receiver/Transmitter v

Description
Additional software components required
Select component from list

NXP iMX7D CM4 devices

v b Keill. MCIMX7D-SABRE:Board Support.iMX7D SABRE Board HW INIT Additional software components required

~ /A, require Cclass="

<

Components| Device Packs

5I5", Cgroup="CORE"

Select component from st

NOTE
Saving the RTE configuration triggers a project update and the selected software
components become instantly visible in the Project Explorer.
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Configure CMSIS-RTOS RTX Kernel

In the project, expand the group RTE:CMSIS, right-click on the file
RTX Conf CM.c, and select Open With - CMSIS Configuration Wizard.
Change the following settings:

= Default Thread stack size [bytes] 512
»  Main Thread stack size [bytes] 512
=  RTOS Kernel Timer input clock frequency [Hz] 240000000
= "RTX_Conf_CM.c i3 = B8
i= CMSIS Configuration Wizard ER=NG)
Option Value
w Thread Configuration
Mumber of concurrent running user threads 6
Default Thread stack size [bytes] 512 y
Main Thread stack size [bytes] 512 J
Mumber of threads with user-provided stack size 0
Total stack size [bytes] for threads with user-providec 0 J
Stack overflow checking
Stack usage watermark O
Processor mode for thread execution Privileged mode

w RTX Kernel Timer Tick Configuration
Use Cortex-M SysTick timer as RTX Kernel Timer

RTOS Kernel Timer input clock frequency [Hz] 240000000
RTX Timer tick interval value [us] 1000
v System Configuration
Round-Robin Thread switching
User Timers
ISR FIFO Queue size 16 entries

RTOS Kernel Timer input clock frequency [Hz]

Defines the input frequency of the RTOS Kernel Timer.
When the Cortex-M SysTick timer is used, the input clock
is on most systems identical with the core clock.

Source Editor | CM5IS Configuration Wizard

Save the file.

NOTE

If you have opened a file with the CMSIS Configuration Wizard once, your choice
is stored and the file will be opened in this view automatically next time.




30

Create Cortex-M4 Applications

Create the Source Code Files

Add your application code using pre-configured User Code Templates containing
routines that resemble the functionality of the software component. Right-click on
the project and select New => Files from CMSIS Template.

& New Files from CMSIS Ternplate O X
CMSIS User Code Template
This wizard creates new files from CMSIS user code template.
=
Project: | Blinky
Component MName
v e CMSIS
¢ RTOS.Keil RTX CMBSIS-RTOS 'main’ function
#p RTOS.Keil RTX CMSI5-RTOS Mail Queue
#p RTOS.Keil RTX CMSIS-RTOS Memory Pool
#p RTOS.Keil RTX CMSI5-RTOS Message Queue
» RTOS.Keil RTX CMSI5-RTOS Mutex
#p RTOS.Keil RTX CMSI5-RTOS Semaphore
#p RTOS.Keil RTX CMSI5-RTOS Thread

@ RTOS.Keil RTX
p RTOS.Keil RTX

CMSIS-RTOS Tirner
CMBSIS-RTOS User SVC

Location: |_a'BIinlcy | Browse...
File name: | os0bjects.h main.c |
®

Expand the software component CMSIS and select the template CMSIS-RTOS
'main’ function. Click Finish. Add application specific code to the file main.c:

* CMSIS-RTOS 'main' function template

#define osObjectsPublic
#include "osObjects.h"

#ifdef RTE
#include "RTE Components.h"
#endif
#ifdef RTE CMSIS RTOS
#include "cmsis_os.h"

#endif

#include "system iMX7D M4.h"
#include "retarget io.h"
#include "board.h"

#include <stdio.h>

// define objects in main module
// RTOS object definitions
// Component selection

// when RTE component CMSIS RTOS is used
// CMSIS RTOS header file
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osThreadId tid threada; /* Thread id of thread A */
S R
* Thread A
K */

void threadA (void const *argument) {
volatile int a = 0;
for (;;) {
osDelay (750) ;
printf ("Blinky threadA: Hello World!\n");

}

osThreadDef (threadA, osPriorityNormal, 1, 0);

/*

* main: initialize and start the system
=Y

int main (void) {
/* Board specific RDC settings */
BOARD RdcInit();

/* Board specific clock settings */
BOARD ClockInit();

SystemCoreClockUpdate () ;
InitRetargetIOUSART () ;

tid threadA = osThreadCreate (osThread(threadA), NULL);

#ifdef RTE CMSIS RTOS // when using CMSIS RTOS
osKernellInitialize (); // initialize CMSIS-RTOS
#fendif

/* Initialize device HAL here */

#ifdef RTE_CMSIS_RTOS // when using CMSIS RTOS
osKernelStart (); // start thread execution
#endif

/* Infinite loop */
while (1)

{
/* Add application code here */

osDelay (1000) ;
printf ("Blinky main loop: Hello World!\n") ;

// initialize peripherals here

// create 'thread' functions that start executing,
// example: tid name = osThreadCreate (osThread(name), NULL) ;

osKernelStart (); // start thread execution

}



32

Create Cortex-M4 Applications

Adapt the Scatter File

On the i.MX 7 devices, several types of memory are available. For deterministic,
real-time behavior, the Cortex-M4 provides local Tightly Coupled Memory
(TCM), which provides low-latency access. Multiple on-chip RAM areas
(OCRAM) are available, which are larger, but not as fast.

The following table shows the memories and their load addresses for the different

processors:
Region Size Cortex-A7 Cortex-M4 (Code Bus)
OCRAM 128KB | 0x00900000-0x0091FFFF | 0x00900000-0x0091FFFF
TCMU 32KB | 0x00800000-0x00807FFF
TCML 32KB | OxO07F8000-0x007FFFFF | Ox1FFF8000-Ox1FFFFFFF
OCRAM_S | 32KB | 0x00180000-0x00187FFF gigggggggg_giggggxii/

By default, the scatter file template uses the start address 0x0 for the load region
command. To put the Cortex-M4 code into the TCM, change the address of the
load region to Ox1FFF8000:

; Kkkkkkkkkkkkkkkkkhkkkhkkhkkkhkkkhkkhhkkhhkkkhkkhhkkhkkkhkkkhkkhkkkkkkk

; ** Scatter-Loading Description File generated by RTE CMSIS Plug-in **
8 hhkkkkkkhkhkhkhkkkhkkkkhkhkhkhkhkkkkkhkhkhkhkhkkhkkhkkkhkhkhkhkhkkkhkkkhkhkhkhkhkkhkkhkkkkhkhkhkhkkkkkkhkhhkkkkkx

LR TROM1 0x1FFF8000 0x00008000 ({

; load region size_region

ER IROM1 0x1FFF8000 0x00008000 { ; load address = execution address
*.o0 (RESET, +First)
* (InRoot$$Sections)

.ANY (+RO)

}

RW_IRAM1 0x20000000 0x00008000 {
.ANY (+RW +ZI)

}
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Build the Cortex-M4 Image

Right-click on the project name and select Build Project to build the application.
This step compiles and links all related source files. The Console shows
information about the build process. An error-free build displays program size
information:

& Console 53 @ﬁ\d':” g al ?x|="E':=J'='E|
COT Build Console [Blinky]

Code (inc. data) RO Data RW Data I Data Debug

13476 1486 1248 laa 6676 5158297 Grand Totals
13476 1486 1248 laa 6676 5158297 ELF Image Totals
13476 1486 1248 lae =] @ ROM Totals
Total RO Size (Code + RO Data) 14724 ( 14.38kB)
Total RW Size (RW Data + ZI Data) 6776 (  6.62kB)
Total ROM Size (Code + RO Data + RW Data) 14524 ( 14.48kB)

'Finished building target: Blinky.axf’

14:09:34 Build Finished (toock 195.942ms) e

£ >
Debug Cortex-M4 Application on page 37 guides you through the required
steps to connect your evaluation board to the workstation and to debug the
application on the target hardware.
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Create Linux Applications

This chapter guides you through the steps required to create and modify projects
for an ARM Cortex-A class device running Linux:

= Setup the Project: create a project.

=  Build the Application Image: compile and link the application.

Setup the Project

From the Eclipse menu bar, choose File 2 New = C Project. In the upcoming
window, select the Hello World ANCI C Project:

& C Project O X

C Project —
Create C project of selected type

Project name: | Hello_World

Use default location

C\Users\USER\Documents\DS-MDK Workspace\Hello_World Browse...
default
Project type: Toolchains:
v (= Executable ~ ARM Compiler 5.06u2
® Empty Project ARM Compiler 6.4
@ Hello World ANSI C Project GCC 4.x [arm-linux-gnueabihf] (built-in)
& CMSIS C/C++ Project v

Show project types and toolchains only if they are supported on the platform

'f?) < Back MNext = Cancel

Enter a project name (for example Hello World) and make sure that the GCC
[-.] (built-in) toolchain is selected before clicking Finish.
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The C/C++ Perspective will open and show the current project:

& C/C++ - Hello_World/src/Hello_World.c - Eclipse Platform - m} H
File Edit Source Refactor Mavigate Search Project Run  Window Help
i [ - -w VRS- G-@-itt-0-@-i® 5 -
s o uccicces | 2 |G % @
[y ProjectExplorer 32 | (21 5. ¥ = O [g] Hello_World.c &3 =8 o#x *» =08
{5 Blinky 3& Name : Hello_World.c[] 13 8 s e
(=5 Hello_World 14 include <stdio.h -
. 11 #include <stdioc.h>
& RPMSG PingPang BM 12 #include <stdlib.h> 5 stdio.h
e N U stdibh
14= int main(void) { © main(void): ir
15 puts(”!!!Helle World!!!"); /* prints !!
16 return EXIT_SUCCESS;
17}
18
L4 > £ >
B Consale &3 = 8
oG HE=-E B

COT Build Conscle [Hello_Weorld]

< >

5 Hello_World

Build the Application Image

Right-click on the project name and select Build Project to build the application.
This step compiles and links all related source files. The Console shows
information about the build process

B Consale 27 2| Tasks ! Problems [C] Properties 4L 4 <§)| B g '_5“| #E~C~= O
COT Build Console [Hello_World]

===== ===== ===== ========== A
Total RO Size (Code + RO Data) 4848 (  4.73kB)
Total RW Size (RW Data + ZI Data) 364 ( @.36kB)
Total ROM 5ize (Code + RO Data + RW Data) 4856 (  4.74kB)
'Finished building target: Hello World.axf'
15:@3:41 Build Finished (tock 1s.116ms)
v
< >

The chapter Debug Linux Application on page 42 guides you through the
required steps to connect your evaluation board to the workstation and to
download the application to the target hardware.
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Debug Applications

The DS-5 Debugger can verify all software applications that execute on a
heterogeneous computer system. Complete system visibility is enabled using
multiple simultaneous debug connections:

(N |
P53

| ARMKEIL ULINKpro

] v
- CoreSight™

¥ +

Cortex®-A Cortex®-M

Linux Kernel
RTOS System

*> gdbserver

Linux Microcontroller
Application Application

DS-5 Debugger Heterogeneous System

* The Cortex-M application is debugged using a ULINKpro debug unit (refer
to www.keil.com/ulink for more information). Users can analyze the
microcontroller application using RTOS aware-debugging and peripheral
views.

= The Cortex-A Linux kernel is also debugged using a ULINKpro debug unit.
The debugger lists kernel threads and processes.

= The Cortex-A Linux application is debugged via gdbserver. The debugger
supports multi-threaded application debugging and shows pending
breakpoints on loadable modules and shared libraries.


http://www.keil.com/ulink
https://en.wikipedia.org/wiki/Gdbserver
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Preparing the Terminal Views

Many applications use a serial connection to display messages. To be able to
view these messages, use a Terminal window that shows data coming from serial
COM ports.

The .MX 7 SABRE development board contains a dual USB serial port device
that offers two independent COM ports. Connect the board to your computer and
Windows will install the drivers that will add two new USB Serial Ports to your
system. Check the exact numbers in the Windows Device Manager (to open it,
type “device manager” in the Windows search bar):

=1 Device Manager o || = [ &R
File Action View Help
L ol Mol 7 BoclRS

47% Ports (COM & LPT) -
EoLagr (COM4)

(COME)
USB Serial Port (COM14)

15" USB Serial Port (COM15)

.} Processars

_/:‘) Security Devices

b -#% Sound, video and game controllers

m

The smaller number is the COM port of the Cortex-A processor, while the larger
number is the COM port of the Cortex-M processor. To open a Terminal view, go
to Window - Show View = Other... Select Terminal = Terminal and click
OK.

Open the settings dialog from the toolbar of the Terminal 1 window:

[#! Problems J=| Tasks ) Consele [T Properties @ Terminall 52 15 i ._,E| = 7 = 0

| Settings |

Change the settings to the following:

= View Title: Terminal Linux

»  Connection Type: Serial

= Port: Use the first of the new COM ports
= Baud Rate: 115200
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Click OK. Press the RST button on the development board to observe the boot
process in the Terminal window. Send any keyboard key to the terminal window

to interrupt the boot process:

[# Problems J=| Tasks & Console [] Properties /& Terminal Linux &2 IS M= UE| ~ A = 0
Serial: (COM14, 115200, 8, 1, None, None - CONMECTED) - Encoding: (ISO-8859-1)

Warning: FEC@ MAC addresses don't match:

Address in SROM is 8@:84:97:04:49:38

Address in environment is @@:84:9f:84:01:d3

Normal Boot
Hit any key to stop autcboot: @

=>

4 [m

NOTE
You must halt the boot loader at this point to be able to launch the Cortex-M4

debug session. Before starting to debug, copy and build the Linux application.

Add another Terminal view to display the output of the Cortex-M4 processor.
Simply use the drop-down selector next to the New Terminal Connection in

o . o . o
Current View... icon T and select New terminal View:

MNew Terminal Connection in Current View...

New Terminal View

Select the larger COM port number and leave the other settings as they are. Name
the Terminal view Terminal M4.
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Debug Cortex-M4 Application

This section explains how to debug the microcontroller application running on the
Cortex-M4. If you are debugging the Blinky application from the previous
chapter, execute the following steps using that project. Here, we will continue
with the RPMSG_TTY RTX M4 project from the Verify Installation using
Example Project chapter.

Stop in U-Boot

To be able to connect to the target, you need to stop U-Boot before it is actually
loading the Linux kernel. Restart/reset the device and observe the bootloader
output on the Terminal Linux. Press any key before the autoboot countdown
expires:

I#1 Problems J=| Tasks E) Console [T Properties (® Terminal CM4 | & Terminal Linux 2 I =i ._,El 7 = = 8
Serial: (COM14, 115200, 8, 1, None, None - CONNECTED) - Encoding: (150-8859-1)
U-Boot 2@15.04-imx v2015.04 4.1.15 1.0.0 ga+gd7d7c43 (Jul @l 2016 - 11:47:23) ~

CPU: Freescale i.MX7D revl.2 at 792 MHz
CPU: Temperature 47 C

Reset cause: POR

Board: i1.MX7D SABRESD RevE

Iac: ready

DRAM: 1 GiB

PMIC: PFUZE3@@ DEV_ID=8x38 REV_ID=8x11
MMC: FSL_SDHC: @, FSL_SDHC: 1

No panel detected: default to TFT43AB
Display: TFT43AB (488x272)

Video: 48@x272x24

m

In: serial
Out: serial
Err: serial

switch to partitions #@, OK
mmc@ is current device

Net: FECE

Normal Boot

Hit any key to stop autoboot: @
=3
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Configure CMSIS DS-5 Debugger

Launch the DS-5 Debugger using the Cortex-M4 project context menu.

Right-click the RPMSG_TTY_RTX_ M4 project and select Debug As -
CMSIS DS-5 Debugger:

& Debug Configurations

EI-EN

[E] C/C++ Application

[E] C/C++ Attach to Application

[E] C/C++ Postmortem Debugger

[E] C/C++ Remote Application
~ W CMSIS DS-5 Debugger

W RPMSG_TTY_RTX_M4

#5 DS-5 Debugger

@’ IronPython Run

a IrenPython unittest

1 Java Applet

[31 Java Application

Ju JUnit

a7 Jython run

a’ Jython unittest

= Launch Group

PyDev Django

L3 PyDev Google App Run

eP Python Run

éJ Python unittest

E_’ Remote Java Application

Filter matched 20 of 20 items

ey
|\2/|

Create, manage, and run configurations
Launch a D5-5 debugging session using a CMSI5 DS-5 Debugger project.

Mame: | RPMSG_TTY_RTX_M4

4 Connection .4 Advanced | € 05 Awareness

Project Selection

& RPMSG_TTY_RTX_WM4

Connection Settings

Connection Type ULINKpro

Connection Address | P1443217:Keil ULINKpro

Browse...

Target Configuration...

Apply Revert

Connection

Verify the Connection Settings and ensure that ULINKpro is correctly detected.

If in doubt, use Browse... to list available debug adapters.

Click on Target Configuration... to setup the Debug and Trace Services Layer

(DTSL).
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& Debug and Trace Services Layer (DTSL) Configuration for ULINKpro [m| x

Debug and Trace Services Layer (DTSL) Configuration for ULINKpro
Add, edit or choose a DTSL configuration
= B B2y g MName of configuration:  default

Trace Capture | Cortex-A7 | Cortex-M4 . ETR| ITM | CTl Synchronization
Enable Cortex-M4 core trace

Enable Cortex-M4 trace
Enable ETM Timestamps

= On the Cortex-A7 tab, disable all trace options to avoid buffer overflows.

= On the Cortex-M4 tab, Enable Cortex-M4 core trace.

OS Awareness

In the OS Awareness tab chose the real-time operating system used in your
application using the drop-down menu.

& Debug Configurations X

Create, manage, and run configurations

Launch a D5-5 debugging session using a CM5I5 D5-5 Debugger project.

: Y

IR Name: | RPMSG_TTY_RTX_M4
typefilter text € Connection | € Advanced | 4§ 05 Awareness
[E] C/C++ Attach to Application A ~
[£] C/C++ Postmortem Debugger Select O5 awareness: | None ~

[€] C/C++ Remote Application EOH;TOS
ree
W CMSIS DS-5 Debugger e

W RPMSG_TTY_RTX_M4

Nucleus
5 DS-5Debugger RTXC
@7 IronPython Run ThreadX
a’ IronPython unittest eForce pC3 Compact
] Java Applet - EI’T‘IEJOS v
— TR C/Os-I
< H pC/Os-l

§ i Apply Revert
Filter matched 21 of 21 items -

To start debugging, click Debug.

NOTE
The error message “Failed to launch debug server” most likely indicates that an
incorrect ULINKpro connection address is selected.
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Run Cortex-M4 Application

Starting the debugger, changes to the DS-5 Debug perspective.

The application loads and runs until main. To start the Cortex-M4 application
click Run in the Debug Control view.
#5 Debug Contrel 52 | [ Project Explorer 4 Remote Systems = B

R IR IR R M O LER- v

a u RPMSG_TTY_RTX_M4 connected
ﬁ Cortex-M4 #1 stopped on breakpoint

Status: connected 05 Support: Enabled

Observe the output of the application in the Terminal M4 window.

NOTE
You can add another Terminal view to the debug perspective by simply opening it
using Window = Show View 2 Terminal.

Debug Linux Application

This section explains how to debug the Linux application running on the
Cortex-A7. If you are debugging the Hello World application from the previous
chapter, execute the following steps using that project. Here, we will continue
with the Linux Application TTY project from the Verify Installation using
Example Project chapter.

For Linux application debugging, the DS-5 Debugger supports connections to the
target using gdbserver.

Before connecting, you must:

= Set up the target with Linux installed and booted. Refer to Install the Linux
Image on page 12.

= Obtain the target IP address or name for the connection between the debugger
and the debug hardware adapter. If the target is in your local subnet, click
Browse and select your target.

Next, you should set up a Remote Systems Explorer (RSE) connection to the
target to download the application onto the target’s file system.
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Setup RSE Connection

Go to Window - Open
Perspective = Other..., then select
Remote System Explorer. Create a | Remote SSH Only System Connection

& New Connection O =

Define connection information

new connection using the =& button.
Select SSH Only and click Next.

Parent profile: V
RSE is using Ethernet to
communicate with the target, thus Host name: | ]
you need to enter the target's IP Comectionname: | M7 5A8Rd |
address into the Host Name field. Descniption: | |
Enter a meaningful name in the [ Verify host name
Connection name box: Configure proxy settings

lf?)' < Back Mext = Cancel

Click Finish. Your connection shows up in the Al RemoteSystems 5% |

: i B = | & -
Remote Systems window: | el %

== @
4 Ef Local
. *2 Local Files
5 Local Shells
4[5 i.MXT_SABRE
. *2, Sftp Files
% Ssh Shells
.:_?\,,'J Ssh Terminals

Boot Linux

NOTE

If you are debugging a microcontroller application simultaneously, you need to
run the Cortex-M4 application, otherwise the Linux Terminal will not be
accessible and you will not be able to boot Linux.

In the Terminal Linux enter “boot” to start the Linux system:

B App Console @ Target Console €] Error Log | 8 Terminal Linux 52 = M=l BE| g ¥ = O
Serial: (COM14, 115200, &, 1, None, None - COMNECTED) - Encoding: (150-8859-1)

Warning: FEC® MAC addresses don't match: -
Address in SROM is B8:84:97:84:49:88

Address in envircnment is ©0:04:9f:84:81:d3

Mormal Boot
Hit any key to stop autoboot: @
=» boo

m

Once the Kernel is running, log in as root (no password required).
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Configure DS-5 Debugger

Right-click on the project Linux Application TTY and select Debug As - Debug
Configurations... . In the Debug Configurations window, select DS-5 Debugger

and then press the | icon to create a new debug configuration. Name it GDB
Debug and select in the Connection tab Linux Application Debug =
Application Debug - Connections via gdbserver - Download and debug
application. The RSE connection from the previous step shows up:

Name: GDBE Debug
<Ji= Connection . [[ii) Files | % Debugger 'E{:- 0S5 Awareness| #9- Arguments [ Environment

Select target
Select the manufacturer, board, project type and debug operation to use. Currently selected:

Linux Application Debug / Application Debug / Connections via gdbserver / Download and debug application
Filter platforms

Connect to already running application -~
Download and debug application
Start gdbserver and debug target-resident application

D5-5 Debugger will download your application to the target system and then start a new gdbserver session to debug the application. This
configuration requires ssh and gdbserver on the target platform.

Connections

RSE connection | i.MX7_SABRE -

Address: | Use RSE Host

gdbserver (TCP) | port: 5000
| Use BExtended Mode
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On the Files tab, in Target Configuration, select the workspace build target for
Application on host to download. Select an existing directory on the target file
system, e.g. /home/root/tmp as the Target download directory.

Select an existing directory on the target file system, e.g. /home/root/tmp as

the Target working directory (use the same directory as for Target download
directory).

Name: GDBE Debug

<it= Connection |lizi} Files . &% Debugger 'Eé}- 05 Awareness| (= Arguments P Environment

Target Configuration

Application on host to download:

S{workspace_loc/Linux Application TTY/Debug/Linux Application TTY}

File System...| |W0rkspace.‘. /| Load symbals

Target download directory:

Shome/root/tmp

Target working directory:

Shome/root/tmp

On the Debugger tab, under Run Control select Debug from symbol “main”.
Click Debug.
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Run Linux Application

In the Terminal Linux, load the kernel module that communicates with the
Cortex-M4 application using the following command:

root@imv7dsabresd:~# modprobe -v imx rpmsg_ tty

The kernel module should be loaded as shown below:

insmod /lib/modules/4.1.15-
1.1.0+ga4d2a08/kernel/drivers/rpmsg/imx_rpmsg_tty.ko
imx rpmsg_tty rpmsg0: new channel: 0x400 -> 0x0!
Install rpmsg tty driver!

Now you can run the Linux application by clicking the Continue ¥* button. The
App Console shows the application’s messages:

B App Conscle 32 | = E Eagl == 8
‘5, Linked: GDB Debug =
Preparing the debug session

# cd "/home/root/tmp"”

# export LD_LIBRARY_PATH=".:/home/root/tmp:3LD_LIBRARY PATH"

# gdbserver :5888 "/home/root/tmp/Linux Application TTY"
Process /fhome/root/tmp/Linux Application TTY created; pid = 385
Listening on port 5@ee

Debug session has been started, connecting to gdbserver

Remote debugging from host 18.41.5.21

Get Message From Remote Side: Hello from M4!

Child exited with status @

Similarly, the Terminal M4 shows the output of the microcontroller application:

14} Disassembly F| Memory = Stack ¢ Trace [-|Events = Outline &% Terminal M4 3 = O

M EEHE 2E-
Serial: (COM15, 115200, 8, 1, None, None - CONMECTED) - Encoding: (150-8853-1)

RPM5G TTY RTX Demo...

RPMSG Init as Remote

Mame service handshake is done, M4 has setup a rpmsg channel [@ ---> 1824]
Get Message From Master Side: "Hello from A7!™ [len : 14]

NOTE
You can add another Terminal view to the debug perspective by simply opening it
using Window =2 Show View =2 Terminal.
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Store Cortex-M4 Image

To store the Cortex-M4 Image for execution at start up use the following steps:
1. Create BIN image file using the fromelf utility application.
2. Store this BIN image on SD card in the boot partition
3. Setup the U-Boot environment to start-up the BIN image file.

Create a Cortex-M4 BIN Image File

Right-click the project and select Properties > C/C++ Build - Settings. In the
the Build Steps enter under Post-build steps the Command:

fromelf --bin --output "Blinky.bin" "Blinky.axf"

< Properties for Blinky O *
type filter text Settings f=1R - w
Resource
Builders .
w C/C++ Build Configuration: |Debug [Active ] ~ | | Manage Configurations...

Build Variables
Environment

Logging ) Tool Settings Build Steps Build Artifact [mb Binary Parsers @ Error Parsers
Settings
Tool Chain Editor Pre-build steps
C/C++ General Command:
Project References | \,|

Run/Debug Settings -
Description:

| > |

Post-build steps

Command:
[ fromelf -bin --output "Blinky.bin" "Blinky.ax" ~|
Description:
| ]
W
@

NOTE
This example shows the steps for the Blinky application from section Blinky with
CMSIS-RTOS RTX on page 22.

Click OK and rebuild the project to get the BIN file generated.
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Store Cortex-M4 BIN Image File on SD Card

The SD Card has two partitions:
* The Linux file system partition.
=  The FAT32 boot partition.

List them using the fdisk command:

~# fdisk -1

Device Boot Start End Sectors Size Id Type
/dev/mmcblkOpl 8192 24575 16384 8M c W95 FAT32 (LBA)
/dev/mmcblk0p2 24576 1236991 1212416 592M 83 Linux

To execute the binary Cortex-M4 image at system startup, it must be stored in the
FAT32 boot partition using the following steps:

1. Create a sub-directory on the Linux file system, for example:
~# mkdir /media/sdO

2. Mount the Linux file system partition for access with RSE.

~# mount -t vfat /dev/mmcblkOpl /media/sdO

3. Use RSE to copy the binary image file from your workspace to the
/media/sd0 directory.

4. Unmount the partition to ensure that the file is written correctly:

~# umount /media/sd0

5. Reboot the system and halt in U-Boot.
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Run Cortex-M4 BIN Image File from U-Boot

At this point, the Cortex-M4 BIN image file is stored in the boot partition.

Use the setenv command at the U-Boot prompt to change the U-Boot setup the
new image file:

=> setenv md4image Blinky.bin; save

Verify the boot setup using the printenv command:
=> printenv
loadm4image=fatload mmc ${mmcdev}:${mmcpart} 0x7F8000 ${m4image}

m4boot=run loadmd4image; bootaux 0x7F8000
m4image=Blinky.bin

Run the m4boot process to start the Blinky application:

=> run mdboot

NOTE
For more information refer to the U-Boot Command Line Interface in the U-Boot
user's manual (www.denx.de/wiki/DULG/UBoot).



http://www.denx.de/wiki/DULG/UBoot
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